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RESUMO 

 

DIAGNÓSTICO DA ÁREA DE PRESERVAÇÃO PERMANENTE DO 

ARROIO RAIZ NA ÁREA URBANA DO MUNICÍPIO DE CONDOR – 

RS  

 

 

AUTORA: Caroline da Silva Weschenfelder 

ORIENTADOR: Willian Fernando de Borba 

 

A expansão territorial intensa dos centros urbanos é evidente e vem causando sérios malefícios 

sociais e ambientais cada vez mais graves, como por exemplo a degradação dos rios, seja em 

suas margens ou ainda na qualidade da água. Com isso, é comum que estes sejam utilizados 

como canais de destinação para o lançamento de resíduos sólidos, onde ocorre certa ausência 

de infraestrutura de saneamento básico. Assim, esse estudo tem por objetivo mapear a área de 

preservação permanente e identificar os principais impactos presentes no trecho urbano do 

Arroio Raiz, em Condor - RS. O Arroio Raiz é pertencente à Bacia do Rio Ijuí, na qual o 

município de Condor – RS faz parte. O mapeamento foi realizado por meio do uso de 

ferramentas de geoprocessamento, já a identificação das principais ações antrópicas se deu por 

visitas in loco. Foi identificado que a área de estudo, por meio da expansão urbana, não possui 

a faixa de preservação ambiental proposta na legislação vigente em alguns pontos, além disso, 

verificou-se a presença de resíduos sólidos lançados irregularmente direto no rio, ou nas suas 

margens. Com base nisso, conclui-se que a área apresenta problemas relacionados a sua 

preservação, sendo necessária, onde for possível, seu isolamento para a recuperação natural ou 

ainda, o plantio de espécies florestais, visando a sua regeneração. Recomenda-se ainda, o 

mapeamento dos pontos de lançamento de esgotos domésticos, e a realização de campanhas de 

conscientização da população, evidenciando a importância do manancial para a sociedade.  

 

Palavras-chave: APP. Arroio Raiz. Bioengenharia. Código Florestal. Geoprocessamento.  

 

  



 

 

 

ABSTRACT 

 

THE PERMANENT PRESERVATION AREA DIAGNOSIS OF ARROIO 

RAIZ IN THE URBAN AREA OF THE MUNICIPALITY OF CONDOR – 

RS 
 

AUTHOR: Caroline da Silva Weschenfelder 

ADVISOR: Willian Fernando de Borba 

 

The intense territorial expansion of urban centers is evident and has been causing increasingly 

serious social and environmental harm, such as the degradation of rivers, either on their banks 

or even in water quality. As a result, it is common for these to be used as disposal channels for 

the release of solid waste, where there is a certain lack of basic sanitation infrastructure. Thus, 

this study aims to map the permanent preservation area and identify the main impacts present 

in the urban stretch of Arroio Raiz, in Condor - RS. The Arroio Raiz belongs to the Ijuí River 

Basin, in which the municipality of Condor - RS is part. The mapping was carried out using 

geoprocessing tools, while the identification of the main anthropic actions was carried out 

through on-site visits. It was identified that the study area, through urban expansion, does not 

have the environmental preservation range proposed in the current legislation in some points, 

in addition, it was verified the presence of solid waste irregularly thrown directly into the river, 

or on its banks . Based on this, it is concluded that the area has problems related to its 

preservation, being necessary, where possible, its isolation for natural recovery or even the 

planting of forest species, aiming at its regeneration. It is also recommended to map the points 

of release of domestic sewage, and to carry out awareness campaigns for the population, 

highlighting the importance of the source for society. 

 

Keywords: APP. Stream Source. Bioengineering. Forest Code. Geoprocessing. 
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1. INTRODUÇÃO 

 

Atualmente a discussão sobre as questões ambientais tem ganhado ênfase na sociedade 

devido à preocupação com a extração de recursos naturais, vistos que eles estão se esgotando, 

bem como a poluição ocasionada pelas ações antrópicas. Aliado a isso estão as Áreas de 

Preservação Permanente (APP), que conforme o Código Florestal, Lei nº 12.651 de 25 de maio 

de 2012 (BRASIL, 2012), são caracterizadas como: 

Área protegida, coberta ou não por vegetação nativa, com a função ambiental de 

preservar os recursos hídricos, a paisagem, a estabilidade geológica e a 

biodiversidade, facilitar o fluxo gênico de fauna e flora, proteger o solo e assegurar 

o bem-estar das populações humanas (BRASIL, p. 2, 2012). 

 Elencado a isso, no município de Condor, situado no noroeste do estado do Rio Grande 

do Sul e pertencente à Bacia do Rio Ijuí, tem-se vários arroios, sendo um deles o Arroio Raiz 

(CONDOR, 2022). Este tem parte do seu leito na zona urbana do município, que por sua vez 

tem uma extensa APP. Partindo deste princípio, o objetivo deste trabalho de conclusão de curso 

é realizar um estudo e levantamento de dados a fim de identificar se a área se encontra em boas 

condições ambientais e é respeitada conforme prevê a legislação vigente, e para isso fazendo 

uso de sistemas de informação geográfica.  

 Segundo Vale et al. (2018), o uso de instrumentos de sensoriamento remoto é um forte 

aliado para o conhecimento da superfície terrestre e a associação deste a bancos de dados 

populacionais, como os censos demográficos, e os naturais, como pedológicos e geológicos, 

permitem o conhecimento do perfil local e possíveis tendências.  

O mapeamento do uso e ocupação do solo é de suma importância, visto que o seu uso 

de forma desordenada e não planejada degrada o meio ambiente, logo se faz necessário se 

caracterizá-lo a fim de identificar prováveis modificações na paisagem. Diante disso, têm-se 

utilizado as técnicas de geoprocessamento e sensoriamento remoto aliadas ao Sistema de 

Informação Geográfica (SIG), conforme destaca Lopes (2018). Desse modo, o mapeamento 

facilita a detecção de áreas exploradas de forma inadequada, bem como sua localização, o que 

vem ao encontro do objetivo deste trabalho e de interesse dos órgãos competentes encarregados 

pela fiscalização (CARVALHO, 2020). 

 Campos (2007) pondera que a poluição do solo provoca vários problemas ambientais e 

que podem atingir outros segmentos do meio ambiente, como os mananciais, rios, lençóis 

freáticos, entre outros. Também, inúmeras consequências ambientais como por exemplo o 



 

 

 

desequilíbrio do ecossistema, por meio da extinção de plantas e animais da região atingida, e 

até mesmo a perda da capacidade de drenagem natural do referido solo. 

Vindo ao encontro da gestão ambiental, que para Barsano e Barbosa (2018), que se 

caracteriza como a ciência que estuda e administra o exercício de atividades econômicas e 

sociais de forma que se utilize de maneira racional os recursos naturais, renováveis ou não, 

visando a preservação do meio ambiente para todas as gerações. Com a aplicação da gestão 

ambiental, se almeja a garantia da preservação e conservação da biodiversidade, reciclagem de 

matérias-primas e redução dos impactos ambientais oriundos das atividades humanas sobre os 

recursos naturais (ALCÂNTARA; SILVA; NISHIJIMA, 2012; BARSANO; BARBOSA, 

2018). 

 Para tanto, essa pesquisa se faz extremamente importante já que irá realizar o 

diagnóstico da APP e suas condições atuais nas imediações do Arroio Raiz, averiguando se 

condizem com a legislação vigente. Através de visitas no local do trecho urbanizado, será 

possível analisar e interpretar as condições e a aplicabilidade de técnicas de bioengenharia em 

locais degradados, visando contribuir com a sua preservação. 

  

1.1.OBJETIVOS 

 

1.1.1 Objetivo geral 

 

Realizar um diagnóstico da APP no trecho urbanizado do Arroio Raiz localizado no 

município de Condor - RS.  

 

1.1.2 Objetivos específicos  

 

- Realizar o mapeamento de uso e ocupação do solo na área de estudo no Município de 

Condor/RS; 

- Mapear no local de estudo as APPs conforme exigência da legislação vigente; 

- Mapear e identificar as áreas degradadas no local de estudo; e  

- Indicar eventuais ações que possibilitem a recuperação ambiental das áreas em estudo. 

 

  



 

 

 

2. REVISÃO BIBLIOGRÁFICA 

 

A revisão bibliográfica irá apresentar, de maneira sucinta, as principais informações 

relacionadas as áreas de preservação permanente, como o uso e ocupação do solo. A partir disso 

se faz importante ter conhecimento do histórico das legislações nas quais asseguram a sua 

preservação bem como de técnicas para a sua recuperação e conservação, como as de 

bioengenharia. E, para tal, se fará o uso do geoprocessamento de dados acerca do assunto, visto 

sendo essa uma técnica muito utilizada. 

 

2.1 ÁREA DE PRESERVAÇÃO PERMANENTE (APP) 

 

Conforme a Lei nº 12.651, de 25 de maio de 2012 (BRASIL, 2012), são APP as áreas 

protegidas, que são cobertas ou não por vegetação nativa, e consistem em espaços territoriais 

legalmente protegidos, ambientalmente frágeis e vulneráveis, podendo ser públicas ou privadas, 

urbanas ou rurais (BRASIL, 2012). As APPs possuem diversas funções como por exemplo, 

preservar os recursos hídricos, paisagem, estabilidade geológica e a biodiversidade, proteger o 

solo bem como assegurar o bem-estar das populações. Segundo o Art. 4º, considera-se Área de 

Preservação Permanente, em zonas rurais ou urbanas, para o efeito desta Lei:  

I – As faixas marginais de qualquer curso d’água natural perene e intermitente, 

excluídos os efêmeros, desde a borda da calha do leito regular, em largura mínima 

de: a) 30 (trinta) metros, para cursos d’água de menos de 10 (dez) metros de 

largura; b) 50 (cinquenta) metros, para cursos d’água que tenham de 10 (dez) a 50 

(cinquenta) metros de largura; c) 100 (cem) metros, para cursos d’água que tenham 

de 50 (cinquenta) a 200 (duzentos) metros de largura; d) 200 (duzentos) metros, 

para cursos d’água que tenham de 200 (duzentos) a 600 (seiscentos) metros de 

largura; e) 500 (quinhentos) metros, para os cursos d’água que tenham largura 

superior a 600 (seiscentos) metros;  

II – As áreas no entorno dos lagos e lagoas naturais, em faixa com largura mínima: 

a) 100 (cem) metros, em zonas rurais, exceto para o corpo d’água com até 20 

(vinte) hectares de superfície, cuja taxa marginal será de 50 (cinquenta) metros; b) 

30 (trinta) metros, em zonas urbanas;  

III – As áreas no entorno dos reservatórios d’água artificiais, decorrentes de 

barramento ou represamento de cursos d’água naturais, na faixa definida na 

licença ambiental do empreendimento;  

IV – As áreas no entorno das nascentes e dos olhos d’água perenes, qualquer que 

seja sua situação topográfica, no raio mínimo de 50 (cinquenta) metros;  

V – As encostas ou partes destas com declividade superior a 45º, equivalente a 

100% (cem por cento) na linha de maior declive;  

VI – As restingas, como fixadoras de dunas ou estabilizadoras de mangues;  

VII – os manguezais, em toda a sua extensão;  

VIII – As bordas dos tabuleiros ou chapadas, até a linha de ruptura do relevo, em 

faixa nunca inferior a 100 (cem) metros em projeções horizontais;  

IX – No topo de morros, montes, montanhas e serras, com altura mínima de 100 

(cem) metros e inclinação média maior que 25º, as áreas delimitadas a partir da 

curva de nível correspondente a 2/3 (dois terços) da altura mínima da elevação 



 

 

 

sempre em relação à base, sendo esta definida pelo plano horizontal determinado 

por planície ou espelho d’água adjacente ou, nos relevos ondulados, pela cota do 

ponto de sela mais próximo da elevação;  

X – As áreas em altitude superior a 1.800 (mil e oitocentos) metros, qualquer que 

seja a vegetação; 

 XI – Em veredas, a faixa marginal, em projeção horizontal, com largura mínima 

de 50 (cinquenta) metros, a partir do espaço permanentemente brejoso e 

encharcado. (BRASIL, 2012. pg. 5,). 

  

Quando localizadas em meio urbano, as APPs desenvolvem diversas funções, como por 

exemplo, a proteção do solo prevenindo a ocorrência de desastres associados ao uso e ocupação 

inadequados de encostas e topos de morro, e, a manutenção da permeabilidade do solo e do 

regime hídrico (AZEVEDO; OLIVEIRA, 2014). Também contribuem na prevenção contra 

inundações e enxurradas, o que colabora para a recarga de aquíferos e evita o comprometimento 

do abastecimento público de água em qualidade e quantidade (BRASIL, 2012). 

 

2.2 HISTÓRICO DO CÓDIGO FLORESTAL BRASILEIRO 

 

O primeiro Código Florestal Brasileiro foi instituído a partir do Decreto 23.793, de 23 

de janeiro de 1934, e tinha como objetivo principal normalizar o uso das florestas. Sendo assim, 

no seu Art. 1ª dispõe sobre a preocupação em se considerar as florestas nacionais em seu 

conjunto, reconhecendo as mesmas como de interesse social, ou seja, um bem jurídico de 

interesse comum à sociedade brasileira (BRASIL, 1934). É importante salientar que a medida 

que marcou este documento, foi a delimitação de área mínima a ser preservada nos latifúndios 

privados, ou seja, estabeleceu que em todas as propriedades deveriam ser mantidas reservas 

florestais que compreendessem no mínimo 25,00 % da área total da propriedade (SANTOS 

FILHO et al., 2015 p. 282).  

 No ano de 1962 foi proposta uma nova reformulação do Código Florestal através da Lei 

Federal de nº 4.771, na qual foram mantidos os objetivos, mas também se preocupou com a 

preservação dos recursos hídricos e as áreas de risco, as encostas íngremes e dunas, 

denominadas como “florestas protetoras” (SANTOS FILHO et al., 2015 p. 284). Nesta 

reformulação é que se começa a falar sobre as áreas de preservação permanente, as APPs, estas 

definidas em 5 m, e reserva legal determinadas em 50,00 % da Amazônia e 20,00 % das demais 

regiões do Brasil (BRASIL, 1965). 

 Vale ressaltar que no ano de 1988 institui-se a Constituição da República Federativa do 

Brasil, a qual estava destinada à (BRASIL, 1988, p. 10): 



 

 

 

Assegurar o exercício dos direitos sociais e individuais, a liberdade, a segurança, 

o bem-estar, o desenvolvimento, a igualdade e a justiça como valores supremos de 

uma sociedade fraterna, pluralista e sem preconceitos, fundada na harmonia social 

e comprometida, na ordem interna e internacional, com a solução pacífica das 

controvérsias (BRASIL, 1988, p. 10). 

  

E que também trouxe em sua estrutura o meio ambiente como direito e garantia 

fundamentais, assegurando em seu Art. 225 (BRASIL, 1988, p. 132): 

Todos têm direito ao meio ambiente ecologicamente equilibrado, bem de uso 

comum do povo e essencial à sadia qualidade de vida, impondo-se ao Poder 

Público e à coletividade o dever de defendê-lo e preservá-lo para as presentes e 

futuras gerações (BRASIL, 1988. pg 132). 

 

 A partir disso, o meio ambiente continua em destaque, em 1986 é sancionada a Lei 7.803 

que em seus Art. 2º e 16º, §2º, dispõe sobre o tamanho das faixas de terra ao longo de rios e que 

não deveriam ser ocupadas, bem como sobre a averbação da reserva legal no registro de imóveis 

competente. 

 No ano de 2009 iniciaram-se discussões sobre melhorias no Código Florestal Brasileiro, 

sendo assim, para tal ato, criou-se uma Comissão Especial na Câmara dos Deputados. A 

comissão contou com 11 projetos de lei que propunham adequações ao código, trazendo uma 

nova regulamentação acerca do que afeta as áreas de preservação permanente, reserva legal e 

áreas verdes urbanas bem como a criação das áreas de uso restrito para a proteção e uso 

sustentável de planícies pantaneiras e pantanais (SANTOS FILHO et al., 2015 p. 284). A Lei 

12.651 foi sancionada em 25 de maio de 2012, sofrendo modificações em outubro do mesmo 

ano. 

 

2.3 USO E OCUPAÇÃO DO SOLO 

 

Segundo Behr (2014), tem-se que o uso e ocupação do solo urbano é o reflexo do 

processo de ocupação do território determinado por condicionantes naturais e sociais, que 

produzem efeitos diversos na paisagem e no ambiente. O mapeamento do uso e ocupação do 

solo é de suma importância, visto que o uso de forma desordenada e não planejada degrada o 

meio ambiente, assim se faz necessário caracterizá-lo a fim de identificar prováveis 

modificações na paisagem.  

Diante disso, têm-se utilizado as técnicas de geoprocessamento e sensoriamento remoto 

aliadas ao Sistema de Informação Geográfica (SIG), e, a partir disso, a aplicação em 

mapeamento do uso e cobertura do solo (LOPES, 2018). Logo, com o mapeamento facilita-se 



 

 

 

a detecção de áreas exploradas de forma inadequada bem como sua localização precisa, o que 

ao encontro do interesse dos órgãos competentes encarregados pela fiscalização. 

 

2.4 GEOPROCESSAMENTO 

 

Segundo Jensen (2009) sensoriamento remoto é a arte e a ciência de obter informações 

sobre um objeto sem estar em contato físico direto com o objeto. O autor ainda registra que esta 

ferramenta pode ser usada para medir e monitorar importantes características biofísicas e 

atividades humanas na Terra. Ou seja, pode ser considerado uma significativa ferramenta, uma 

vez que, as fotos aéreas e imagens tomadas a partir de radares ou satélites retratam o espaço 

terrestre e a sua evolução (MIRANDOLA, 2006). 

Um SIG é um sistema que realiza o processamento de dados gráficos e alfanuméricos 

focando nas análises espaciais e modelagens de superfícies (MARQUES, 2019). Ele possui a 

função de integrar dentro de uma base de dados, as informações espaciais advindas de dados 

cartográficos, realiza a compilação de dados de censo e cadastro urbano e rural, juntamente com 

imagens de satélite, redes e modelos numéricos de terreno (INPE, 1991). 

 Diversos estudos utilizam o SIG como ferramenta de mapeamento na área ambiental, 

visto que para muitos estudos é imprescindível analisar os aspectos geográficos e o acesso as 

informações dos atributos descritivos das áreas a serem avaliadas (FAVRIN, 2009). Por 

exemplo, o armazenamento da geometria do perímetro do empreendimento a ser licenciado, a 

potencialidade de executar análises complexas de diversas fontes, criando um banco de dados 

georreferenciado (CÂMARA; DAVIS, 2001). Sendo assim, os recursos de SIG envolvem a 

capacidade de reunir e avaliar diversas informações espaciais (ESTES; STAR, 1990). 

 

2.5 IMPACTO DA URBANIZAÇÃO NOS RECURSOS HÍDRICOS 

 

Segundo Tucci (2006), o processo de urbanização no Brasil vem ocorrendo de forma 

acelerada e imprevisível desde o final da década de 60 sem um planejamento adequado de 

infraestrutura para suportar o crescimento populacional. Em consequência, esse processo tem 

aumentado a exposição da sociedade à determinados riscos, como poluição das águas e ar, 

contaminação da água e do solo por produtos nocivos, produção de resíduos e humana em áreas 

de risco de deslizamentos e inundações (JATOBÁ, 2011). 



 

 

 

O processo de ocupação urbana desacelerado aliado com o uso intensivo do solo pode 

causar diversas consequências para o meio ambiente natural (CONSERVA, 2019). Aliado a 

isso, pode-se citar a destruição de matas para a construção de loteamentos, a impermeabilização 

do solo para a construção civil e a ocupação de áreas de riscos contribuem para a degradação 

ambiental (CARRIJO; BACCARO, 2000).  

 

  



 

 

 

3. MATERIAIS E MÉTODOS 

 

3.1 CARACTERIZAÇÃO DA ÁREA DE ESTUDO 

 

O município de Condor está localizado na Mesorregião Noroeste Rio-Grandense 

(Figura 1) e faz parte da microrregião Geográfica de Ijuí, na qual faz divisa com os municípios 

de Palmeira das Missões (norte), Panambi (Sul), Santa Bárbara do Sul (leste), e a oeste, com 

Ajuricaba e Nova Ramada (CONDOR, 2013). Segundo o IBGE (2010), possui área territorial 

de 463.568 km2 e a população é de 6.552 pessoas, dessas 2.518 pessoas residem na área rural e 

4.034 pessoas residem na área urbana. 

 

Figura 1 - Localização geográfica do município de Condor-RS. 

 
Fonte: Autora (2022). 

 

Condor está em crescente desenvolvimento e crescimento, situado na região do Planalto 

Médio do Estado do Rio Grande do Sul. Sendo pertencente à microrregião colonial de Ijuí, é 

um município eminentemente agrícola, tendo como suas principais atividades econômicas a 

plantação de soja, trigo e milho e, é emergente na bacia leiteira e gado de corte.  Já o setor 

industrial, é formado por microempresas e agroindústrias (CONDOR, 2022). 



 

 

 

O município está localizado da Bacia Hidrográfica do Rio Uruguai, estando inserido na 

Bacia Hidrográfica do Rio Ijuí (CONDOR, 2013) conforme apresenta a Figura 2. A Bacia 

Hidrográfica do Rio Ijuí possui uma área territorial de 10.703,78 km2 e é integrada por 36 

municípios do estado do Rio Grande do Sul. Seus principais rios são: Caxambu, Conceição, 

Ijuí, Ijuizinho e Potiribu (TOMASI; ROISENBERG, 2019). 

 
Figura 2 - Hidrografia do município de Condor-RS. 

 
Fonte: CONDOR (2013). 

  

Em relação a geologia, o município de Condor se enquadra em Serra Geral, este sendo 

de característica rochosa. Segundo o Sistema Brasileiro de Classificação de Solos (EMBRAPA, 

2018) o mesmo possui 3 diferentes tipos de solos, sendo eles: Neossolos Litolicos Eutroficos, 

Latossolos Vermelhos Distróficos e Latossolos Vermelhos Distroferricos, conforme a figura 3.  

 

 

 



 

 

 

Figura 3 - Tipos de solos do município de Condor-RS. 

 
Fonte: Autora (2022). 

 

3.2 BASE DE DADOS E GEORREFERENCIAMENTO  

 

Para o presente trabalho criou-se uma base de dados para o armazenamento e 

organização dos dados necessários para a realização do estudo, sendo eles: 

a) Dados vetoriais em formato shapefile: 

- Os dados de áreas úmidas foram obtidos através do site da Fundação Estadual de 

Proteção Ambiental Henrique Luis Roessler (FEPAM, 2005).  

- Limite do país, estados, municípios do Rio Grande do Sul, biomas e tipos de solos 

extraídos do site do Instituto Brasileiro de Geografia e Estatística (IBGE, 2005). 

b) Imagens do Sentinel-2  

- Registradas no dia 01 de novembro de 2022, denominadas 22JBQ e 22JBP (ESA 

COPERNICUS, 2022). 

c) Imagens Google Earth 

 

 



 

 

 

3.3 GEOPROCESSAMENTO 

 

Para todos os procedimentos, desde a geração de mapas, projeção de coordenadas, ajuste 

de shapefiles e processamento das imagens, utilizou-se o software da Environmental Systems 

Research Institute (ESRI) ArcGis na versão 10.7 (ESRI, 2022).  

O primeiro procedimento realizado foi a obtenção dos dados necessários, após fez-se o 

seu tratamento. Com os arquivos de imagens baixados do Sentinel-2A, ambos do dia 

01/11/2022 denominadas 22JBP e 22JBQ, fez-se a união das duas imagens tornando-as uma 

só. Para tal ação, utilizou-se a ferramenta “mosaico para um novo raster”, que se encontra em 

ArcToolBox > Data Management Tools > Raster > Raster Dataset > Mosaic to a New Raster. 

A junção das duas imagens é necessária para que a visualização da área do município seja 

completa, visto que a imagem da área territorial do mesmo se encontra dividido entre as duas. 

Posteriormente foi possível extrair do shapefile de municípios do RS os dados do 

município de Condor, o qual serviu como base para todos os demais arquivos (recursos hídricos, 

solos, área de preservação permanente, imagens Sentinel-2A, etc). Para tal, foi feito uso da 

ferramenta “Extract by Mask” para cada uma das imagens separadamente. A ferramenta se 

encontra em ArcToolBox > Spatial Analysis Tools > Extraction > Extract by Mask. 

Com os arquivos devidamente ajustados para o estudo, foi realizada a projeção dos 

shapefiles para o Datum Sistema de Referência Geocêntrico para as Américas (SIRGAS) 2000 

e a conversão das coordenadas para Universal Transversa de Mercator (UTM). Esse passo é 

importante, visto que os dados baixados se encontram cada um com uma projeção diferente. A 

ferramenta responsável para a projeção dos arquivos vetoriais se encontra em 

ArcToolBox>Data Management Tools > Projections and Transformations > Project. E para as 

imagens raster, ArcToolBox > Data Management Tools >Projections and Transformations > 

Raster > Project Raster. 

 

3.4 DELIMITAÇÃO DA APP URBANA 

 

Esta foi identificada por meio da ferramenta “buffer”, onde delimitou-se o curso d’água 

e posteriormente admitiu-se largura de 10 m (visto que ela varia ao longo da extensão urbana 

de 3 a 10m) e a faixa de APP para até essa largura deve ser de 30 m (BRASIL, 2012).  

Primeiramente para selecionar os eixos da área escolhida para trabalhar, na barra editor 

deu-se “start editing” na edição do shape do rio delimitado: selecionou-se o arroio e depois 



 

 

 

“Split” para adicionar sobre a linha pontos de corte na seção (processo esse realizado para 

ambos os lados). Após, atribui-se valor do buffer como se refere a legislação ambiental, sendo 

assim: criou-se na tabela de atributos do arroio, um campo para armazenar os diferentes valores 

de raio no qual o ArcGis irá utilizar para gerar o buffer. Abrindo a janela de atributos do 

shapefile, digitou-se o valor de “10” e com isso selecionou os trechos do arroio com essa 

largura, após clicou-se na célula e digitou-se o valor “30”. Por afim, após a inclusão, na barra 

editor, salvou-se a edição e clicou-se me “stop editing”. 

Após seccionar o leito do arroio, preencheu-se a informação da zona marginal na tabela 

de atributos, para gerar o buffer separadamente. O processo é feito primeiro para um lado do 

curso d’água e depois para outro, através dos passos: 

1) Seleciona o trecho de borda superior; 

2) Na barra menu padrão: geoprocessing > buffer; 

3) Na caixa buffer – indicar o shapefile a ser trabalhado, selecionar a pasta onde será 

armazenado o novo shapefile a ser gerado com as áreas de buffer, em “side type” 

escolher a opção “right” (que indica o algoritmo que se deseja gerar oa buffer do lado 

direito da linha selecionada) e em, “dissolve type” escolheu-se a opção “ALL” (que 

indica que o algoritmo deverá dissolver todas as barreiras de cada buffer a ser gerado). 

4) Clicar em “ok”. 

 

3.5 MAPA DE USO E OCUPAÇÃO DO SOLO 

 

O mapa de uso de ocupação do solo foi elaborado objetivando a análise do atual estado 

ocupacional do município de Condor. A imagem de satélite supracitada pertencente a missão 

Sentinel-2A serviu como base. Para esta etapa primeiramente foi feita a mosaicagem das duas 

imagens (união) e após a composição das bandas espectrais a partir da ferramenta “composite 

bands” do ArcGis. 

Para a geração das classes de uso e ocupação do solo realizou-se a vetorização poligonal 

não supervisada (JENSEN, 2009; LONGLEY et al., 2013), a partir da imagem de satélite como 

plano de fundo. Para a definição do tipo de classe de uso, o embasamento teórico será 

proveniente do Manual Técnico de Uso da Terra (IBGE, 2013). 

 

 

 



 

 

 

4. RESULTADOS E DISCUSSÃO 

 

4.1 USO E OCUPAÇÃO DO SOLO 

 

Sabendo que o município de Condor é eminentemente agrícola e possui como principais 

atividades econômicas o cultivo de soja, trigo e milho, recentemente também aderiu a 

bovinocultura leiteira e de corte. Além de ser destaque na produção de leite no Estado, 

possuindo capacidade produtiva de 29 milhões de litros por ano, o município também possui as 

maiores empresas produtoras de sementes certificadas do Brasil e da América Latina 

(CONDOR, 2022). A partir da Figura 4 é possível identificar as áreas de cultivo, de vegetação 

e a pequena área urbana da cidade de Condor. 

 

Figura 4 - Mapa de uso e ocupação do solo de Condor-RS. 

 
Fonte: Autora (2022). 

 

Após a análise e classificação em tela da distribuição espacial do Uso e Ocupação do 

Solo no município de Condor, usando como instrumento norteador o Manual de Uso de Terra 

(IBGE, 2013). Utilizou-se a classificação IsoCluster do limite, por meio da ferramenta 

classificação e optando-se por usar 5 classes para tal. Fazendo uma adaptação do mesmo para 

a área em questão, foram identificadas duas principais classes diferentes de uso, sendo essas: 



 

 

 

área de cultivo agrícola ou ocupação (urbanização, residências) e área com vegetação 

(florestas). O Quadro 1 apresenta as características de cada uma das áreas, conforme IBGE 

(2013). 

Quadro 1 - Descrição das características do uso e ocupação da área analisada. 

Classes Características 

Área com vegetação (floresta) 

“A vegetação natural compreende um conjunto de estruturas florestais e 

campestres, abrangendo desde florestas e campos originais (primários) e 

alterados até formações florestais espontâneas secundárias, arbustivas, 

herbáceas e/ou gramíneo-lenhosas, em diversos estágios sucessionais de 

desenvolvimento” (IBGE, 2013) 

Área em uso e/ou ocupação 

(agrícola ou não) 

“A terra agrícola pode ser definida como terra utilizada para a produção de 

alimentos, fibras e commodities do agronegócio. Inclui todas as terras 

cultivadas, caracterizadas pelo delineamento de áreas cultivadas ou em 

descanso, podendo também compreender áreas alagadas. Podem se constituir 

em zonas agrícolas heterogêneas ou representar extensas áreas de 

“plantations”. Encontram-se inseridas nesta categoria as lavouras temporárias, 

lavouras permanentes, pastagens plantadas, silvicultura e áreas 

comprovadamente agrícolas cujo uso não foi identificado no período do 

mapeamento” (IBGE, 2013). 

“A esta nomenclatura está associada a todos os tipos de uso da terra de 

natureza não agrícola, florestal ou água, tais como áreas urbanizadas, 

industriais, comerciais, redes de comunicação e áreas de extração mineral” 

(IBGE, 2013) 

Fonte: Construído a partir de IBGE (2013) 

 

Vale ressaltar que a classificação Iso Cluster é realizada de forma automatizada no 

software, ou seja, pode haver erro na identificação das áreas. Em seu estudo Faria (2015) 

considerou o algoritmo de classificação Iso Cluster como satisfatório, pois atingiu bons 

resultados. No trabalho desenvolvido por Nascimento et al. (2016) também houve a necessidade 

de edição para a correção manual de classes temáticas que o Iso Cluster não distinguiu. A Figura 

5 ilustra as classes presentes no município de Condor, objeto de estudo. É possível observar 

que a área com maior abrangência no município são as áreas em ocupação, entre as quais 

também se encontra inserida a zona urbana da cidade. 

 

 

 

 



 

 

 

 

Figura 5 - Mapa de uso e ocupação do solo classificado para áreas com floresta e em uso e/ou ocupação, segundo 

o IBGE (2013). 

 
Fonte: Autora (2022). 

 

4.2 ÁREAS DE PRESERVAÇÃO PERMANENTE 

 

O Arroio Raiz é um importante recurso hídrico do município de Condor, sua extensão é 

de aproximadamente 14 km desde a nascente até sua foz no Rio Palmeiras (e posteriormente 

no Rio Ijuí). Conforme dispõe a Lei Municipal nº 2.393 (CONDOR, 2016), o trecho urbano 

abrange os bairros Raiz, Olaria, Bom Jesus e faz o contorno do Loteamento Costa Verde (Figura 

6).  

Durante o processamento dos dados, analisou-se 2,16 Km da extensão total do Arroio 

Raiz, que percorre os bairros Raiz, Olaria e Bom Jesus. A partir desta análise, obteve-se cerca 

de 104.240,33 m2 (10,424 ha) de faixa de APP no trecho urbano – considerando que os trechos 

do Arroio não ultrapassam 10m de largura, e logo, segundo o Código Florestal Brasileiro Art. 

4º, I (BRASIL, 2012): “I - as faixas marginais de qualquer curso d'água natural perene e 

intermitente, excluídos os efêmeros, desde a borda da calha do leito regular, em largura mínima 

de: a) 30 (trinta) metros, para os cursos d'água de menos de 10 (dez) metros de largura”. 



 

 

 

 
Figura 6- Mapa de bairros do município de Condor-RS. 

 

Legenda de cores: Marrom – Bairro Raiz;  Roxo – Bairro Olaria; Laranja – Bairro Bom Jesus; Verde – 

Loteamento Costa Verde; Rosa – Bairro Morada Feliz; Cinza – Bairro Dona Emília; Amarelo – Centro; 

Vermelho – Bairro Liberdade; Rosa bebê – Bairro Farroupilha. 

Fonte: Prefeitura Municipal (2022). 

 No trecho urbano que o Arroio Raiz cruza possui uma pequena área APP documentada 

e preservada delimitada, a Figura 7 traz como exemplo o Bairro Raiz. A partir deste, é possível 

identificar a crescente urbanização e ocupação do solo no município de Condor no entorno do 

arroio e sua faixa de APP. A Figura 7 também apresenta os quatro pontos visitados in loco e o 

um dos trechos urbano onde se torna visível que a faixa de APP não é respeitada conforme 

prevê o Código Florestal Brasileiro (BRASIL, 2012). 

Na Figura 8, é possível analisar os pontos críticos, que segundo a análise, não estão em 

conformidade com a legislação vigente. Estes, somam-se 24.707,146 m2 (2,47 ha) em 

inconformidade, cerca de 23,7% da área estudada. 

Nessa área, também, pode-se analisar diversos impactos ambientais. Entre eles, a 

urbanização em torno da faixa próxima à área de preservação permanente nos Bairros Olaria e 

Bom Jesus. Ademais, a relação com a área de cultivo agrícola, disposição de resíduos de forma 

inadequada e desmatamento em torno do Arroio Raiz no trecho que passa pela área urbana no 

Bairro Raiz.  

 



 

 

 

Figura 7– Área de estudo no trecho urbano do município de Condor-RS. 

 
Fonte: Autora (2023). 

 

Figura 8 - Mapa da APP existente e APP faltante do Arroio Raiz na área urbana do município de Condor-RS. 

 
Fonte: Autora (2023). 



 

 

 

A partir de visitas in loco no bairro Olaria e Raiz, foi possível observar alguns trechos 

onde há acúmulo de resíduos sólidos dentro do Arroio (Figuras 8), bem como córregos que 

fazem deságue no mesmo e que se encontram em situações precárias de conservação. Em 

relação a faixa de APP da área urbana, a mesma varia de acordo com os trechos (ora menores, 

ora maiores). No bairro Olaria e nos pontos visitados a faixa de APP possui 30 m, visto que 

nestes a largura do mesmo varia de 3 a 10 m, conforme apresentado no quadro 2. 

 
Quadro 2 - Pontos de visita in loco. 

Ponto Largura (m) Coordenadas 

1 6,4 28°11'55.0"S 53°29'03.0"W 

2 3,85 28°11'56.0"S 53°29'04.0"W 

3 9,7 28°11'56.0"S 53°29'05.0"W 

4 5,5 28°11'56.0"S 53°29'07.0"W 

Fonte: Autora (2022). 

 

Figura 9- Descarte inadequado de resíduos e situações das margens de acesso. 

  

Fonte: Autora (2022). 

 

 Como supracitado, através das visitas in loco identificou-se a presença de resíduos 

sólidos encontrados no ponto 1 dentro do arroio e na margem do ponto 2 visitado. Outros dois 

pontos no trecho também foram analisados, ambos com largura menor que 10 m (9,7 m e 5,5 



 

 

 

m) e com faixa de APP com 30 m. Com exceção do ponto 1, os demais pontos apresentavam 

visivelmente boas condições de uso e não continham resíduos sólidos visíveis em seu interior. 

Em relação a faixa de APP, em ambos os lados do arroio, a mesma é respeitada conforme prevê 

o Código Florestal Brasileiro (BRASIL, 2012). 

O despejo de resíduos sólidos no arroio é uma grande preocupação em relação a sua 

preservação, visto que, contribuem para sua contaminação e má aparência. Para corrigir a 

problemática, a Prefeitura Municipal de Condor já realizou a implementação de uma 

“ecobarreira flutuante” (Figura 9) no trecho de estudo próximo ao ponto 1, cerca de 5m à 

montante.  Esta, foi instalada em novembro de 2021, entretanto não há registro de análise dos 

resíduos coletados e tão pouco a sua quantidade visto que, segundo pesquisa realizada junto a 

Prefeitura Municipal, a mesma foi arrastada pela enxurrada que aconteceu dias após sua 

instalação e o projeto não foi retomado. 

 

Figura 10 - Ecobarreira flutuante. 

 
Fonte: CONDOR (2021). 

 

4.3 AÇÕES PARA A RECUPERAÇÃO DA FAIXA DE APP 

 

Com os resultados obtidos, é possível propor melhorias para o trecho em questão de 

acordo com o que prevê a legislação vigente. Dentre as medidas propostas, estão o isolamento 



 

 

 

da área (Quando possível) visando a regeneração natural da margem ou ainda o reflorestamento 

de espécies florestais, identificação de pontos de descarte de efluentes e a conscientização da 

população que reside próximo ao curso de água.  Essas ações irão servir como base para 

implementação de um plano de recuperação, e ainda, cumprir o exigido pela legislação.  

Para acelerar a recuperação ambiental das áreas também podem ser utilizadas as técnicas 

de nucleação de poleiros, dentre elas pode-se citar: poleiros artificiais e/ou naturais, 

transposição de solos de áreas próximas, transposição de sementes e enleiramento de galharia 

(LEAL FILHO et al., 2013; FRAGOSO et al., 2017; TRENTIN et al., 2018). Técnicas de 

nucleação possibilitam o aumento da biodiversidade local, obedecendo aos estágios naturais da 

sucessão ecológica de uma floresta nativa, onde os núcleos criados atrairão biodiversidade das 

áreas circundantes (MARIOT et al., 2007). 

Alinhado a isso, afim de garantir a preservação de todos os trechos do Arroio Raiz e 

demais cursos d’água do município, ações de sensibilização ambiental com a comunidade 

condorense se fazem indispensáveis. A educação ambiental, segundo a Política Nacional de 

Educação Ambiental, Lei Federal nº 9.795/99, “é um componente essencial e permanente da 

educação nacional, devendo estar presente, de forma articulada, em todos os níveis e 

modalidades do processo educativo, em caráter formal e não-formal” (BRASIL, 1999). Com 

isso, pode-se citar como exemplo de ação a ser aplicada:  

- Divulgação de materiais online através das mídias sociais da Prefeitura Municipal ou 

a entrega destes para os munícipes durante as visitas das Agentes de Saúde do município; 

- Fiscalização através Setor de Saneamento e Meio Ambiente no que diz respeito ao 

tratamento de esgoto do doméstico gerado nas residências ao entorno da faixa de APP – para 

que não se tenha o despejo deste direto no leito, por exemplo; 

- Disposição de coletoras nos trechos em que o Arroio Raiz se torna acessível para 

visitas e/ou para recreação, se for o caso, afim de instruir a destinação correta de resíduo; 

- Retomada do projeto da Ecobarreira Flutuante, de forma que se faça eficaz, resistente 

a fortes chuvas e que os resultados sejam divulgados para a comunidade – afim de reafirmar o 

compromisso que todos possuem com a preservação do mesmo. 

 

 

 

 



 

 

 

5. CONSIDERAÇÕES FINAIS 

 

A metodologia aplicada utilizando como ferramenta principal o geoprocessamento, 

possibilitou de forma eficaz identificar as áreas de preservação permanente no trecho analisado. 

Além de que, se mostrou ser uma alternativa rápida, simples e válida para avaliar a 

sustentabilidade dos recursos hídricos e ocupação do solo, e pode servir como instrumento 

auxiliar na tomada de decisão de gestores públicos para ações corretivas do meio.  

A área apresentou trechos onde a faixa de APP não está dentro da legislação vigente, 

cerca de 23,7% da faixa existente, além da presença de lançamento de resíduos (sólidos), tanto 

no leito do rio ou ainda em sua margem. Nos quatro pontos visitados, os limites das áreas de 

preservação permanente são respeitados em três deles, conforme prevê a legislação vigente. No 

Bairro Raiz, Olaria e Bom Jesus a faixa de APP não é de acordo com o que estabelece o Código 

Florestal conforme os resultados geoprocessados encontrados, visto que possui muito próximo 

do seu entorno residências.  

Como ações de preservação, recuperação e mitigação, recomenda-se o isolamento das 

áreas (quando possível), visando a sua regeneração natural ou ainda o plantio de espécies 

florestais, auxiliando na manutenção da área de preservação. Ainda, a realização de campanhas 

de sensibilização com a comunidade poderia servir de amparo para a correta preservação dos 

recursos hídricos. Por fim, a realização deste estudo tem grande importância para a formação 

de Engenheiros Ambientais e Sanitaristas, pois possibilita que se tenha aprofundamentos de 

estudos em relação as legislações ambientais e a conservação de recursos hídricos.  
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